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About this manual
Congratulations on your purchase of the NCSS statistical package! The NCSS statistical
package offers:
• Easy data entry.
• Statistical routines that provide high quality and accuracy yet are quick and easy to

learn and use.
• Straightforward procedures for creating paper printouts and file copies of both the

results of the statistical analyses and graphical representations of those results.

Our goal is that with the help of this NCSS Quick Start booklet, you will be up and
running on the system in less than one hour. Specifically, you will quickly and
successfully complete the following tasks:
• Enter a small set of data into NCSS (that is, create a database), label the variables, and

print a hard copy of your data.
• Compute descriptive statistics on the data in the database which you created.  Also,

run a t-test and a regression analysis on your data.
• Print copies of the descriptive statistics reports and the other reports which you

generate.  Also, print graphical representations of those analyses.  Also, export your
text and graphic material to a word processing program such as Microsoft Word or
WordPerfect.

I believe you will find that this NCSS Quick Start booklet provides a quick, easy,
efficient, and effective way for first-time NCSS users to get up and running. NCSS users
needing details on how to execute particular tasks should find the self-help chapters in the
second half of this booklet very useful.

I look forward to any suggestions you have to improve the usefulness of this manual
and/or the NCSS system. Meanwhile, good computing!

Jerry Hintze, Author
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CHAPTER 1

Installation
Before you install

Check system requirements
NCSS can run on any system that can run 32-bit Windows applications. This includes Windows 98,
Windows ME, Windows NT 4.0, or  Windows 2000. The recommended minimum system is a
Pentium PC with 32 MB of memory. NCSS has been tested on systems with only 16 MB of memory.

NCSS takes up about 25 MB of disk space. If space is tight, you can reduce this by deleting its help
(*.hlp) files. Once installed, NCSS requires about 5 MB of temporary disk space while it is running.

Find a home for NCSS
Before you start installing, decide on a directory where you want to install NCSS . By default, the
setup program will install NCSS in the NCSS97 (or NCSS2000) directory of your C drive. You may
change this during the installation, but not after, so make sure you have the required disk space on
the drive you will install NCSS on.

What install does
When you insert the CD into your computer, it will automatically load and run the installation
program SETUP.EXE contained in the NCSS97 directory on the CD. If you have previous installed a
copy of NCSS, the installation program will replace all outdated files with their current versions.

This version of NCSS contains PASS within it. If you have not purchased PASS, you will be able to
try it out for 30 days from the date you first use it. After the trial period, you will need to purchase a
separate license to continue using PASS.
The installation procedure (Setup) creates the necessary directories and copies the NCSS and PASS
programs from the CD to those directories. The files on the CD are compressed, so Setup
decompresses these files as it copies them to your hard disk.

The directories created by Setup are (either NCSS97 or NCSS2000 may be substituted below):

\NCSS2000 (or your substitute directory) contains most of the program files.

\NCSS2000\DATA contains all of the database files used by the tutorials. We recommend creating a
sub-directory of this directory to contain your data.

\NCSS2000\JUNK contains temporary files used by the program while it is running. Under normal
operation, NCSS will automatically delete temporary files. After finishing NCSS , you can delete any
files left in this directory.

\NCSS2000\REPORT is the default directory in which to save your output.
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\NCSS2000\SETTINGS contains the files used to store your program options. These files are used by
the NCSS Template system which is described later.

\NCSS2000\STS contains all labels, text, and online messages. The text in these files may be
customized. For example, you may want to modify report headings or help messages. You may even
want to translate this text into languages other than English.

Setup places a file called NCSS97.INI in your Windows directory. This file contains all default
settings, paths, and constants that are used by the system. This file is documented in README.WRI.

If you have a previous version of NCSS
If you are upgrading from a previous version of NCSS, instruct the Setup program to install the new
version in the same directory as your previous version (usually \NCSS97). All appropriate files will
be replaced. This includes your template files in the SETTINGS directory. If you want to keep these,
you must copy them to a separate directory before you begin the installation and copy them back
after completing the installation.

Installing NCSS
This section gives instructions for installing NCSS on your computer system. You must use the
NCSS Setup program to install NCSS. The files on the CD are compressed, so you cannot simply copy
the diskettes to your hard drive.

After you run Setup, you should read the NCSS README.WRI file for late-breaking information
before starting NCSS.

Follow these basic steps to install NCSS on your computer system.

Step Notes

1. Make sure that you are using a 32-bit version of Windows such as Windows ME or Windows
2000.

2. Insert the CD in the CD drive. On the Start menu, select the Run command. Enter D:Setup
(You may have to substitute the appropriate letter for your CD drive if it is not D.).

3. Once Setup starts, simply follow the instructions on the screen. NCSS will be installed in the
drive and directory you designate.

If something goes wrong during installation
The installation procedure is automatic. You simply put the appropriate diskettes in the floppy drive
when directed. If something goes wrong during installation, delete the \NCSS97 directory and start
the installation process at the beginning. If trouble persists, contact our technical support staff as
indicated below.

Obtaining the Documentation
A complete set of documentation is contained on this CD in the directory /NCSS97/DOCS. This
directory contains Adobe Acrobat PDF files that can be easily browsed and printed. A
comprehensive table of contents is contained in the text file _READ_ME.TXT. You can access this
file by double-clicking on it from Windows Explorer or by loading it into your word processor.
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The DOCS directory also contains a free copy of Adobe Acrobat Reader 4.0. You can install the
reader by double-clicking on the file Acrd4enu.exe. Note that this is a copyrighted program from
Adobe. You should read their licensing agreement that says that you can not sell the Reader program.

Note that to access the CD, you insert it and wait for the installation window to appear. Instead of
installing the software, select Cancel Installation. Now you can use Windows Explorer to browse the
CD.

Starting NCSS
NCSS may be started using your keyboard or your mouse using the same techniques that you use to
start any other Windows application.

Starting NCSS using your mouse
You can start NCSS by selecting NCSS from your Start menu using standard mouse operations.

Starting NCSS using your keyboard
You can start NCSS by selecting NCSS from your Start menu using standard keyboard operations.

Obtaining Help
Online Help
To help you learn and use NCSS efficiently, most of the material in this manual is included in the
online Help. The online Help is started from the Help Menu.
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Since the Help information is stored electronically, it can be changed more quickly than the printed
manual. Hence, you should always look to the online Help for information on procedures that is not
contained in this manual. Also, whenever you notice differences between the online instructions and
the printed instructions, you should assume that the online instructions are more current and follow
them.

Using Help
There are a few key features of our help system that, if you understand, will let you use the online
help more efficiently.

First, the Contents button brings up the table of contents of the help system. Use the Contents button
to quickly navigate through the Help system.

Second, each chapter was designed to be easily navigated. You can then proceed through a chapter
section by section using the period and comma keys on your keyboard.

Finally, you can use the Index and Find buttons to bring up an index of subjects.

Technical Support
To help us answer your questions more accurately, we may need to know about your computer system.
Please have pertinent information about your computer and operating system available. Also, many help
calls will require us to have an understanding of your data. Be prepared to provide background on your
data.

You can contact our technical support by calling (801) 546-0445 between 8 a.m. and 5 p.m. (MST).
You can contact us by email at Support@NCSS.COM or by fax at (801) 546-3907. Our goal is to
respond to Email within 24 hours and to faxes within 3 days, so please use Email whenever possible.
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CHAPTER 2

Creating a
database
About this chapter (Time: 21 minutes)
This chapter will show you how to enter, label, save, and print a database. You will find complete
coverage of these subjects in the first four chapters of the NCSS Users Guide.

Starting NCSS
Select Programs - NCSS from the Start menu to start NCSS. After starting, the NCSS  spreadsheet
program appears with an empty datasheet. We will begin by entering data into this datasheet.



6  Creating a database

Brain Weight Data
The following data give the body weight in kilograms and the brain weight in grams of various
mammals. This chapter will show how to enter these data into an NCSS  database and perform basic
database operations such as saving and printing.

Mammal Body Brain
Name Weight Weight
African Elephant 6654 5712
Asian Elephant 2547 4603
Giraffe 529 680
Horse 521 655
Cow 465 423
Gorilla 207 406
Pig 192 180
Jaguar 100 157
Man 62 1320
Chimpanzee 52 440
Gray Wolf 36 120
Kangaroo 35 56
Baboon 11 179
Red Fox 4 50
Cat 3 26

Entering a column of data
Take the following steps to enter the brain weight data into NCSS :

1 Position the cursor in the
upper-left cell.

This is done by clicking in the
cell just below the C1.

2 Type African Elephant.

Notice that as you type, the
characters appear in two
places: in the cell where you
are typing and in the cell-edit
box at the top of the sheet.
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3 Press Enter.

The text is entered and
the cell cursor (the dark
border around the cell)
moves down to the next
cell.

4 Type Asian Elephant.
Press Enter.
Type Giraffe.
And so on until you
finish entering the
names.

5 Using the vertical scroll
bar or the Page Up key,
reposition the screen so
that you can begin
entering data in the
second column.
Click in the first row of
column two. This will
highlight this cell.

6 Type in the second and
third columns of
numbers. The
completed table should
appear as shown.

To cancel an entry, you can
press the Esc key. If you
have already pressed Enter,
you can choose Undo from
the Edit menu.
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Labeling a variable
In NCSS, a column of data is called a variable. Each variable has a number and a name. The number is
its column number. The name is the label at the top of the column. The name of the variable will be
displayed in all statistical reports and graphs that you generate, so it is important to name variables so
that they will be remembered.

In a new database, the variables receive the default names C1, C2, C3, etc. Hence, you have just
entered data into variables C1, C2, and C3. We will now show you how to change the names of these
variables.

1 Click on the Variable Info tab.

2 Click in the C1 cell.

This will position the cell cursor
in that cell. (The cell cursor
may already be there.)

3 Type Name.
Press Enter.
Type Body_Weight.
(Use the underscore, not the
minus sign in these names.)
Press Enter.
Type Brain_Weight.
Press Enter.

4 Click on the Sheet1 tab.

This will return you to a view
of the data. The screen should
appear like this.
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The final step is to widen
the columns so that the
complete names and
labels are shown.

5 Drag the mouse from the
Name heading to the
Brain_Weight heading.
This is done by pressing
the left mouse on the
heading Name and, without letting up, moving the mouse pointer to the heading Brain_Weight and
finally letting up on the mouse. All three columns (headings and data) will be darkened.

6 Now, position the mouse
between the two columns.
The mouse pointer will
change to a two
directional arrow.

7 Drag the mouse to the
right until you are almost
to the next border and let
go of the mouse button.

The columns will be
widened, showing the
complete variable names
(column headings) and
animal names.
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8 Click on a cell in the body of
the table to cancel the selection
(the reverse video).

Variable names are used throughout the program to identify which columns of data to analyze. A
variable name must begin with a letter (not a number); should contain only letters, numbers, and the
underscore; and should not contain blanks. For correct formatting on reports, variable names should be
less than fourteen characters, although there is no maximum length.

Saving your database
As you enter data, it is stored in your computer’s temporary memory but not on your hard disk. If the
computer loses power, you lose your data. We will now show you how to save the data  to your hard
disk.

1 Select Save As from the
File menu of the Data
window.
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2 Double-click the Data
directory to open it.

3 Enter mydata.s0 in the File
Name box.

4 Click Save.

An NCSS database name must end with the file extension s0 (that’s “s zero”). Hence, a valid file name
would have numbers, spaces, and letters followed by the extension “s0”. For example, you might use
abc.s0.

The database is stored as two files on your hard disk. If you use Windows Explorer to view the Data
directory, you will find that you have created two files: mydata.s0 and mydata.s1.

Printing your database
You will often want to create a printout of the data you have entered. We will now show you how this
is accomplished.

1 Select Data Report from
the Data menu.

The Data Report
procedure appears. This
window allows you to
control the format of your
report.

2 Click on the button to the
right of the Data Variables
line.
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3 Select the first three variable
names: Name,
Body_Weight, and
Brain_Weight.

Press Ok.

These variable names will
appear in the Data Variables
box.

4 Enter 2.0 in the First box of
the Tabs section at the
bottom of the window.

5 Press the Run button on the
right of the toolbar at the top
of the window.
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The final result will appear as
shown.

6 Finally, select Print from the File
menu of the Output window. This
will display the Print dialog box
from which you can print the
report.

Congratulations! You have successfully entered and printed a set of statistical data. Analyzing these data
using the various statistical procedures will not be much more difficult.



14  Creating a database

Clearing the database
As you move from analysis to analysis, you will often have to clear the datascreen so that new data may
be entered. This is done as follows. (Of course, you should save your data before clearing it!)

2 Click Ok.

This will clear the screen and
present you with an empty file
just like when you start the
program.

NCSS maintains two data formats. The spreadsheet (S0-type) format is for routine databases of under
1000 rows. The database (S0Z-type) format is for databases with more than 1000 rows.

1 Select New from the File
menu of the Data window.
(Use the Windows menu
to transfer from the
Output window to the Data
window.)

(If you have not
previously saved your
data, choosing New will
cause the program to ask
you if you want to save
the current datasheet
before it is cleared.)
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The three NCSS windows
As you have just seen, NCSS is controlled by three windows: Data, Procedure, and Output. Each
window has its own menu bar. Be sure you are in the correct window when you use the menu. For
example, the Save As command in the Data window saves your data, the Save Template command in
the Procedure window saves the procedures’s current settings, and the Save As command in the Output
window saves the current report. It is easy to forget which window you are in!

The NCSS Data window contains
the data that is currently being
analyzed. This window lets you
view, modify, and save your data.
It has the look and feel of a
spreadsheet.

Chapter 7 provides a closer look at
the Data window.

This is the main NCSS window.
Closing this window will exit the
program.

The NCSS Procedure windows let
you set the options for a particular
analysis. Whether you are running
a multiple regression, an ANOVA,
or a scatter plot, you will set the
options of this procedure in the
Procedure window.

Chapter 8 provides a closer look at
the Procedure window.

Closing this window will not exit
NCSS.
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The NCSS Output window displays
the output from the statistical and
graphics procedures. It serves as a
mini-word processor--allowing you to
view, edit, save, and print your
output.

Chapter 9 takes a closer look at the
Output window.

Closing this window will not exit
NCSS.

Moving from window to window
There are several ways of moving among the windows:

1 Remove the windows you are not currently using by minimizing them.

2 Arrange the windows on your screen so that all can be seen.

3 Use the task bar along the bottom of your screen.

4 Use the Windows menu.

5 Use the Navigator.

6 Use the toolbar (this is usually the quickest and easiest).
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CHAPTER 3

Data
Transformation
About this chapter (Time: 13 minutes)
This chapter continues the introduction to the NCSS  system by taking you through examples of using
transformations to create new variables. Specifically, you will be shown how to calculate percentages
and how to recode the values of a variable.

Starting NCSS and loading a database
If NCSS is not already running, start it up now by clicking on the NCSS  icon (refer to the beginning of
Chapter 2 for details). We will use the brain weight data that was entered in Chapter 2. These data are
stored in the MAMMALS database in the \NCSS\DATA subdirectory. To begin this tutorial, take the
following steps to load the MAMMALS database.

2 Double click the Data
subdirectory to select it.

1 Select Open from the File
menu of the Data window.

The File Open window will
appear.
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3 Double click mammals.s0 in the
list of available files.

4 Click the Open button.

This will load the MAMMALS
database into the Data window.
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Creating a percentage variable
5 Click on the Variable Info tab.

This will position you in the
Variable Info datasheet.

6 In the Transformation
column, click on the fourth
cell down--the one in the C4
row.

This will position the
spreadsheet cursor in this
cell. This is where the
transformation will be
entered.
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7 Type in the transformation expression:
Brain_Weight/Body_Weight/10.
(Be sure to type the underscores!)

Press Enter.

Notice that you edit the transformation
in the edit bar at the top of the
spreadsheet.

This step enters the new transformation
expression, but does not change the
data. The data are not generated until
the spreadsheet is manually
recalculated.

8 Click on C4 in the Name column and
type Percent and press Enter.

This renames the variable from the
default of C4 to a new value that better
describes the data in this column.

9 Double click on the cell in the fourth row
in the Format column.

This will display the Format window for
editing the format of the Percent
variable. Note that this format will not
influence the internal precision of the
data.
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10 Select the two-decimal format: 0.00
from the list.

Although it is not necessary to
reformat the numbers, it will make
viewing them much easier.

The completed screen will appear like
this.

11 Click the Apply Transformation
button on the toolbar.

This will cause all transformations to
be recalculated.

12 Click the Sheet1 tab.
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This is the final result.

Notice the new column of data
in the Percent variable’s
column.

You can see that the data is
actually stored in double
precision.

If you change or add data to either Body_Weight or Brain_Weight, the Percent variable’s values will
not be automatically recalculated. You must recalculate the database using the Apply Transformation
button or the Recalc All option of the Data menu.

Also remember that these changes are not automatically saved on your hard disk. If you want a
permanent copy of a database with new transformations, you must save this modified version of the
database using the Save option of the File menu in the Data window.



Chapter 3  Data Transformation  23

Recoding a variable
It is often necessary to recode the values of a variable. As an example, we will recode the body weights
to form a new variable as follows. Animals with a body weight less than 100 kg will receive a value of
1. Animals with a body weight greater than or equal to 100 kg will receive a value of 2. The
transformation formula that will accomplish this is (Body_Weight>=100)+1. The expression inside the
parentheses results in a “1” if it is true or “0” if it is false. We will call the new variable SizeGroup.

1 Click the Variable Info tab.

2 Click the C5 name.

3 Type SizeGroup and press
Enter.

4 Click in the cell in the fifth row
and third column.

5 Type (Body_Weight>=100)+1
and press Enter.

6 Press the Apply
Transformations button to
generate the new values.

7 Click on the Sheet1 tab to
return to the data.
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The final result appears like this.

Saving the changes
It is important to save changes to your database. Take the following steps to do this.

1 Choose Save from the File menu of the
Data window.

2 Click Yes.

The MAMMALS database on your hard disk will be replaced with the revised edition.
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CHAPTER 4

Running
Descriptive
Statistics
About this chapter (Time: 8 minutes)
This chapter continues the introduction to the NCSS  system by taking you through an example of
using NCSS to obtain descriptive statistics.

Running descriptive statistics
In this section, you will generate descriptive statistics (mean, standard deviation, etc.) on the
Body_Weight variable in the MAMMALS data. To begin, start NCSS  and load the MAMMALS
database. Detailed instructions for doing this are at the beginning of Chapter 3. After the database is
loaded, follow these steps to run the procedure:

1 From the Descriptive Statistics
menu, select Descriptive Stats.
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The Descriptive Statistics window will
appear.

The next step is to select the variables
to be analyzed.

2 Double click in the Variables box or
click the small button to the right of this
box.

This will cause the Select Variables
button to appear at the top of the
window.

This will cause the Variables window
to appear.

4 Click on Body_Weight in the Variable
Selection List box.

The variable will appear in the
Variables Selected box.

5 Click Ok.

The procedure window reappears.
Note that the Variables option now has
a value of Body_Weight. This is the
name of the variable that was selected.

6 Press the Run button to run the
procedure and generate the following
output report.
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The results are
displayed in
NCSS’s word
processor.

You can scroll
through the
output using
the scroll bars.
You can
enlarge this
window by
double-clicking
the title bar--
the blue bar at
the top
containing the
words NCSS
Output.

Don’t be
intimidated by the amount of output. The default descriptive statistics report contains much more
information than any
one person could
use. Since NCSS is
used by thousands
of people, it must
contain output for
many different
situations. You can
generate only those
reports you want by
making appropriate
selections on the
Reports panel of the
Descriptive
Statistics window.
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We will now show a special trick to use when you want to view the graphics in more detail.

7 Scroll down through the output until
reach the histogram.

8 Double-click the histogram to obtain
a full-screen version of the
histogram.

9 After viewing the graph, close it by
clicking the remove button.
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Saving the output
We will now show you how to save the output so that it can be imported into your favorite word
processor.

1 Select Save As from the File
menu of the Output window.

This will bring up the Save File
As dialog box.

Switch the current directory to
the Report subdirectory which
was provided as a convenient
place in which to save your
reports.

2 Type myreport.rtf in the File
name box.

3 Click Save to save the report.
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Note that the three-character extension “rtf” is very important. RTF stands for rich text format. Other
programs, such as Microsoft Word and WordPerfect, recognize files with this extension as
importable. Hence, using this extension makes sure that other programs will be able to import your
report files.

As an exercise, run your word processor and load the myreport.rtf file.

Printing the output
We will now show you how to print the output.

1 Select Print from the File menu.

This will bring up the Print dialog
box.

You can select which pages you want
to print.

2 Click OK to begin printing.
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CHAPTER 5

Running a Two-
Sample T-Test
About this chapter (Time: 6 minutes)
This chapter continues the introduction to the NCSS  system by taking you through an example of using
NCSS to run a two-sample t-test.

Running a two-sample t-test
In this section, you will conduct a two-sample t-test on data in the MAMMALS1 database. To begin,
start NCSS and load the MAMMALS1 database (be careful to load MAMMALS1, not MAMMALS).
Detailed instructions for doing this are at the beginning of Chapter 3.

Remember to load the database from the Data window.

In this example,
we will compare
the average
percent brain
weight of small
mammals (those
under 100 kg in
weight) to the
same average for
large mammals.
That is, the
response variable
will be Percent
and the grouping
variable will be
SizeGroup.

After the database is loaded, follow these steps to run the procedure:
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1 From the T-Tests submenu of the
Analysis menu, select Two-Sample
T-Test.

The Two Sample Tests procedure
window will appear.

2 Double click in the Response
Variables box.

This will cause the Response
Variables selection window to
appear.

3 Click on the Percent item in the
Variable Selection List box.

4 Click Ok.
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The T-Test window reappears.
Note that the Response Variables
has the entry Percent. This is the
variable that was selected.

6 Double click the top Group
Variable box.

This is the grouping variable. The
average percent of those rows
with a SizeGroup value of 1 (small
animals) will be compared with
the average percent of those rows
with a SizeGroup value of 2 (large
animals).

7 Select SizeGroup from the list of
available variables.

8 Click Ok.

9 Click the Run button to run the
analysis.
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The results are displayed in NCSS’s word processor.

The t-test compares the
mean percent of two
groups. Often, all you will
need is the t-value and
associated probability
level. These are contained
in the Equal-Variance T-
Test Section. In this case
the t-value is 3.6560 and
the probability level is
0.002904. Hence we
reject the null hypothesis
that means are equal.

A quick glance at the
means of the two groups
shows that the mean
percent for small animals
is 1.03 and for large
animals is 0.13. Hence
the two percentages are
an order of magnitude
apart!

The t-test chapter of the
User’s Guide goes into
much more detail on how
to perform a t-test
analysis.

At this point, you could
save or print the t-test report.
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CHAPTER 6

Running a
Regression
Analysis
About this chapter (Time: 10 minutes)
This chapter continues the introduction to the NCSS  system by taking you through an example of
regression analysis. Regression techniques analyze the relationship between a dependent (Y) variable
and one or more independent (X) variables. NCSS  has regression procedures for many different
situations.

Running a regression analysis
In this section, you will conduct a regression analysis using the MAMMALS1 database. To begin, start
NCSS and load the MAMMALS1 database. Detailed instructions for doing this are at the beginning of
Chapter 3.

In this example
we will investigate
the relationship
between
Brain_Weight
(dependent
variable) and
Body_Weight
(independent
variable).



36  Regression Analysis

Creating a scatter plot
The first step in a regression analysis is to plot
the data.

1 From the Graphics menu, select Scatter
Plots.

The Scatter Plot window will appear.

2 Click in the Horizontal Variable(s) box.

3 Enter Body_Weight.

4 Click in the Vertical Variable(s) box.

5 Enter Brain_Weight.

6 Click the Run button on the toolbar.

The scatter plot shown at the right will
appear. In order for regression analysis to
be applied, the points in the plot should fall
along an imaginary straight line.

While studying the plot, notice that all but
two of the point are clustered in the lower
left-hand corner. You cannot tell whether
the points fall along a straight line. This
suggests that a logarithmic scale should be
used to display the data. This will be done
next.
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7 Press the Horizontal tab to display
the Horizontal panel.

8 Select Yes: Numbers from the Log
Scale pull-down list box.

9 Press the Vertical tab to display the
Vertical panel.

10 Select Yes: Numbers from the Log
Scale pull-down list box.

13 Press the Run button to run the
program and generate the following
output.
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The final result is the plot at the right.
Notice that the points now appear to be
evenly spread across the plot. Also note
that the points appear to fall along an
imaginary, upward-sloping straight line.
This implies that a standard regression
analysis should produce a reasonable model
of this data.

Because of the logarithmic scale, our next
task will be to create logarithmic versions of
the two variables.

Create the logarithmic variables
1 Press the Data Window button on the

toolbar to bring the NCSS Data
window to the front of your screen.

This will bring up the NCSS Data
window.

2 Click on the Variable Info tab.

This will bring up the Variable Info
screen.

3 In the sixth row of the Transformation
column enter Log(Body_Weight).

4 In the seventh row of the
Transformation column enter
Log(Brain_Weight).

5 In the sixth row of the Name column
enter LogBody.

6 In the seventh row of the Name
column enter LogBrain.
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7 Click on the Apply Transformations
button to create the tranformed data.

8 Click on the Sheet1 tab to return to your
data. The datasheet will now appear as shown.

Run the regression
1 Select Multiple Regression from the

Regression/Correlation submenu of the
Analysis menu.
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2 Click on the Template tab.

This screen provides a list of previously
stored templates. Loading one of these
templates saves you from having to set
the options individually each time you
run an analysis. The STANDARD
template provides a set of commonly
used reports.

3 Select Standard and press the Load
Template button.

The final step is to select the variables
that are being analyzed.

4 Click on the Variables tab.

5 Enter LogBrain for the Y:Dependent
Variable.

6 Enter LogBody for the
X’s:Independent Variables.

7 Click the Run button on the toolbar.

This will generate the following output.
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The main statistics
of interest in a
regression analysis
are the regression
coefficients and R-
Squared. These are
shown in the
Regression Equation
Section.

Regression
Coefficients

R-Squared

Scroll down to view
the diagnostic plots.
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Of course, a complete regression analysis would require the studying of several reports and plots. A
complete discussion of this is found in the multiple regression chapter of the User’s Guide.
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CHAPTER 7

Data Window
About this chapter
Data may be entered manually or imported from other files. The data are loaded in a spreadsheet from
which they may be viewed, changed, stored, or printed. This chapter will show you how to manipulate
your data using the spreadsheet.

Loading a database
The tutorial in Chapter 2 explained the mechanics of entering, storing, and printing a database, so that
material will not be repeated here. Instead, this chapter will focus on manipulating the data with the
spreadsheet after it has been loaded. Our first task will be to load in a previously saved database.

If NCSS is not already running, start it now by selecting NCSS  from the Windows Start menu (refer to
the beginning of Chapter 2 for details). We will use the brain weight data that was entered in Chapter 2.
These data are stored in the MAMMALS database in the \NCSS97\DATA subdirectory. To begin this
tutorial, take the following steps to load the MAMMALS database.

2 Double click the Data
subdirectory to select it.

1 Select Open from the File
menu of the Data window.

The File Open window will
appear.
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3 Double click mammals.s0 in the
list of available files.

4 Click the Open button.

This will load the MAMMALS
database into the Data window.

The Data window will appear as
shown to the right.
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Copying and pasting data
We will now take you through the steps to copy and paste the data.

1 Position the cursor in row one
column three (at the value
5712).

2 Drag the mouse down to row
six. This will select the first six
rows.

3 Press Ctrl-C. This will copy the
data to a temporary storage
area called the clipboard.

4 Position the cursor in the cell at
row one and column four.

5 Press Ctrl-V to paste the data
from the clipboard. The resulting
screen will appear as shown.
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Changing column widths
Occasionally, you will want to change the width of one or more columns. This section will show you
how this is accomplished. We will resize the columns headed Body_Weight and Brain_Weight.

1 Click on the column heading:
Body_Weight.

2 Drag the mouse into the next
column to the right and let go of the
mouse button. This will select these
two columns.

3 Move the cursor between the third
and fourth columns. The cursor will
change into a double-pointing
arrow.

4 While holding down on the mouse
button, drag it to the left until you
are almost to the next cell border.

5 Let go of the mouse button.

The resulting display will appear
like this.

6 Reverse this process to reset
these columns to their original
width.
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CHAPTER 8

Procedure Window
About this chapter
All NCSS procedures (e.g., t-test, multiple regression, or scatterplot) are controlled by a procedure
window. The Procedure window contains all the settings, options, and parameters that control a
particular procedure. These options are separated into groups called panels. A particular panel is viewed
by pressing the corresponding panel tab that appears just below the toolbar near the top of the window.

The current values of all options available for a procedure are referred to as a template. By creating and
saving template files, you can tailor each procedure to your own specific needs.

Below is a picture of the Descriptive Statistics template. This chapter presents a brief tutorial of how to
operate the Procedure window.

Navigating a procedure window
This section will show you how to move around a procedure window. The window is made up of two
or more panels (in this example there are five panels: Variables, Reports, Prob Plot, Histogram, and
Template). You control a procedure by changing the settings on each of these panels. Hence, navigating
a procedure window simply means that you move from panel to panel.

1 From the Analysis menu,
select Descriptive Statistics,
then Descriptive Stats.

The Descriptive Statistics
procedure window will
appear.

2 Press the Prob Plot tab to
display the Prob Plot panel.
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3 Press the Variables tab to
redisplay the Variables tab.

Notice that many of the option
boxes have small buttons on their
right. These buttons may be used
to activate a separate input
window. For example, if you press
the button to the right of the
Variables box, the Variable
Selection window will appear. This
window will help you select the
variables to be used.



Chapter 8  Procedure Window  49

Changing an option
Suppose you want to change the
Exponent option from None to 3.

1 Press the drop-down button on
the right of the Exponent box.

This will activate the drop-down
menu.

2 Move the scroll bar thumb down
until the 3.0 appears.

3 Move the cursor down so that
the 3.0 is highlighted.

4 Select the 3.0 by clicking it (or
by pressing the Enter key while
the 3.0 is highlighted).

Another way to change this
option is to select it and press 3.
The program searches through
the options for the first item that
begins with a 3.
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Notes on modifying options
Many of the option boxes have alternative methods of entering data. For example, when you need to
select a variable, you can type the variable name directly in the box or you can double click on the box
to bring up a variable selection window.

Entering text
When an option needs text (such as
the title of a graph), type the text
directly into the box. Note that while
you are typing, if you decide to revert
back to the original text, you can hit
the Escape (Esc) key.

Selecting variables
When you need to specify variables,
you can type their names directly into
the box, you can enter their numbers
directly into the box, or you can
activate the variable selection
window.

1 Double click in the Variables
box.

This will display the variable selection
window. You can select the variables
of interest and press the Ok button
when you are finished.

Press the Ctrl key when you want to
select several, noncontiguous,
variables.

As you select variables in the Variable
Selection List box, they will appear in
the Variables Selected box at the
bottom.

It may be convenient to specify
variables by number rather than by
name. For example, when you use
numbers, you can use the same
settings on several databases, even
though the variables have different
names.



Chapter 8  Procedure Window  51

Saving a template
Once you have filled out a procedure, you may want to save your choices so that you do not have to
reset them again the next time you use the procedure. This is accomplished using the Template panel.

In this example, we will save the current settings to a file called TUTOR1.

1 Press the Template tab to
display the Template panel.

2 Enter Tutor1 in the File
Name box. This is the name
where the template is stored.

3 Enter an identifying phrase
in the Template Id box at the
bottom of the screen.

4 Press the Save Template
button to store the template
file.

Note that when you supply the template file name, you do not enter a three-character extension. NCSS
adds the appropriate extension. This extension may be determined by looking at the Template
Directory. In our example, the extension is the number 24.

You should also note that you can delete these files using your Windows Explorer program.
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Loading a template file
In this example, we will load the previously saved Tutor1 template file.

1 Select TUTOR1 from the
available template files.

2 Press the Load Template button.

The settings are reset to how
they were when Tutor1 was
saved.

The default template
Whenever you close a procedure window, the current settings are saved in a template file named
Default. When a procedure is loaded, NCSS checks to determine if the template file Default exists. If
such a file exists, it is automatically loaded after the procedure window is loaded. Hence, the current
settings of each procedure window are preserved between sessions. Because of this, you should avoid
using Default as a template file name.
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CHAPTER 9

Output Window
About this chapter
NCSS sends all statistics and graphics output to its built-in word processor from where they can be
viewed, edited, printed, or saved. Reports and graphs are saved in rich text format (RTF). Since RTF is
a standard Windows document transfer format, these files may be loaded directly into your word
processor for further processing. You can also cut data from the report and paste it into an NCSS
datasheet for further analysis. This chapter covers the basics of our built-in word processor.

This chapter will continue the analysis of the brain weight data that was begun in Chapter 3. If you have
not already done so, run the Descriptive Statistics reports as described in Chapter 4. Our analysis here
will pick up where that chapter ended.

Viewing the output
The output of the Descriptive Statistics program is shown below. Usually, you will find it useful to put
the output window into full-screen mode.

1 Double click on the Output title bar.

This will put the word processor
into full-screen mode.

2 Double click on the document title
bar.

This will put the document in full-
screen mode also.
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The screen will look
similar to this. Note
that the actual size
of your screen
depends on the
resolution of your
monitor, so it will
vary.

3 Select Show All
from the View
menu.

The screen will look
similar to this.

Notice the standard
word processing
ruler, tab bar, and
button bar. These
will aid you in
editing your
document.
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We will now show you a quick
way to move about a lengthy
document such as the current one.

1 Select Goto Section from the
Edit menu.

This will load the Topic Search
window.

2 Select Skewness and
Kurtosis Section.

3 Press Ok.

This will position the
report so that the
desired section title is
showing.

At this point, you
would scroll down through your output, perusing the results. Once you determine that you want to
retain your results, you have four choices:

1 Print the document.

2 Save the document to a file.

3 Add the document to the log. (The log holds the output from several analyses in one file.)

4 Copy the report to a temporary holding area (the Windows clipboard) and paste it into another
application.

Note that you cannot just leave the output in the current window if you want to keep it because it will
be replaced by the next analysis that you run.
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Printing the output
Before printing the report, you should scroll through it to determine if there are any portions that you
want to delete before printing. To print the report, take the following steps.

1 Select Print from
the File menu.

This will bring up
the Print Dialog
box.

2 Click Ok to begin
printing your
report.

Note that this
dialog box may
appear different in
different versions
of Windows.
However, the
basic functionality
will be the same.
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Saving the output to a file
You can save the output to a file. The report is saved in rich text format (RTF) which is a standard
document interchange format. This format may be read into commercial word processors such as Word
and Word Perfect. This will allow you to export the reports to your favorite word processor.

Take the following steps to save the output to a file.

1 Select Save As from
the File menu.

This will bring up
the Save File As
dialog box. Note that
this dialog box may
look different in
Windows 95, but the
basic functionality
will be the same.

2 Enter a file name
such as
myreport.rtf.

Note that the file
name must end with
the extension “rtf.”

3 Click Save to save
your report.
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Saving the output to the log document
An analysis of a set of data usually requires the running of several statistical procedures. The log
document provides a convenient way to store the output from several procedures together in one file.
When you have a report or graph that you want to keep, copy it from the output document to the log
document.

The log document provides four main word processing functions: loading, editing, printing, and saving.
When you load a file into the log document, you can add new output to it. In this way, you can record
your work on a project in a single file, even though your work on that project is spread out over several
days.

Take the following steps to add the current output to the log document.

1 Select Add Output to
Log from the File
menu.

This will copy the
current document to
the log file.

To view the log
document, select Log
from the Window
menu.

The log document resides in memory until you store it. To store the log document, take the following
steps:
1 Select Log from the Window menu so that the log document is active.

2 Select Save As from the File menu and complete the Save File As dialog.

Warning: The log document is not automatically stored. You must store the contents of the log
document to a file before exiting NCSS.
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CHAPTER 10

Filters
About this chapter
This chapter explains how to use filters to limit which rows (observations) are used by a particular
procedure and which are skipped. For example, you might want to limit an analysis to those weighing
over 200 pounds. You would use a filter to accomplish this.

Setting up a filter
Using the MAMMALS database (see Chapter 3), we will setup up a filter so that only those animals
with a body weight greater than 200 kilograms are used in the statistical calculations.

If the MAMMALS database is not currently loaded, select Open from the File menu, move to the
\NCSS97\DATA subdirectory, and double click on the file MAMMALS.S0. Your display should appear
as follows.

1 Select Filter from the Data menu.

This brings up the Filter template.

2 Check the Filter System Active box.
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3 Enter the filter condition,
Body_Weight>200, in the Filter
Statements box.

4 Press the Run button to
activate the filter.

5 The Filter activated box will be
 displayed. Press OK.

The filter is now setup. Notice that
the Filter button on the both the
Data and Filter toolbars has now
changed to a green funnel with the
word On below it. This is a reminder
that the filter system is active.
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We will now show you how to use it in a procedure by obtaining the mean and standard deviation of the
filtered database.

8 Press the Descriptive Statistics
button on the toolbar.

9 Enter Body_Weight in the Variables
box.

10 Check the Filter Active box. This
indicates that you want to use the
currently defined filter with this
analysis.

11 Press the Run button to run the
procedure.
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12 Finally, view the output.

Notice that although fifteen rows were processed, only six rows were actually used in the computations.

Disabling the filter
When you are finished using a filter, you can bring up the Filter procedure window, click the Filter
System Active button so that it is not checked, and press the Run button to run the filter procedure.
This will deactivate the filter.
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CHAPTER 11

Writing
Transformations
About this chapter
The basics of entering transformations were covered in Chapter 3. This chapter gives examples of how
to write more advanced transformations.

Recoding
Background
Data recoding refers to replacing one set of values with another. For example, suppose you have each
individual’s age stored in a variable called AGE. Suppose that you want to create a new variable called
AGEGROUP that classifies each individual into one of four age groups according to the following rule:

AGE Values AGEGROUP Value
1 to 12 1
13 to 19 2
20 to 29 3
30 and above 4

Example of recode
RECODE(Age;  (1:12 = 1) (13:19 = 2) (20:29 = 3) (Else = 4))

Notice the basic syntax of this function. The variable being recoding is given first (here Age). Next, a set
of statements that define the recoding are given.

Example result
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Basic indicator
Background
Indicator transformations are used in logic (if - then) situations. An indicator function evaluates to one if
the condition is true or to zero if the condition is false. The basic syntax is two arguments between
parentheses separated by a logic operator. The possible logic operators are <, >, <=, >=, <>, and =.

Example indicator
(AGE > 20)

If AGE is greater than 20, the result will be a one. Otherwise, the result will be a zero.

Example Result

Compound indicators
Background
Since indicator functions evaluate to a numeric value (either 0 or 1), they may be combined with other
functions--including other indicator functions. When combining several indicators, the logical AND is
achieved by multiplying the indicators and the logical OR is achieved by adding.

Example of compound indicators
(AGE > 20)*(AGE<=40)

If age is greater than 20 and less than or equal to 40, the result will be a one. Otherwise, the result will
be a zero.

Example results

Using
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indicators for if - then
Background
Indicator functions may be used in place of if - then statements. The following examples show how this
is done.

Example 1
If Age is less than 20 set AdjIncome to 5000. Otherwise, set AdjIncome equal to Income.

Example 1 transformation
(Age < 20)*5000+(Age>=20)*Income

Note that the indicator functions used here are opposites. When (Age<20) is 0, (Age>=0) will be 1.

Example 1 results

It may be helpful to look at how this expression works on the first two rows.

Calculation for the first row:

(23<20)*5000+(23>=20)*22000 = 0(5000) + 1(22000) = 22000

Calculation for the second row:

(15<20)*5000+(15>=20)*22000 = 1(5000) + 0(5500) = 5000
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Example 2
If Age is less than 20 set AdjIncome equal to Income + 1000. Otherwise, set AdjIncome to Income +
2000.

Example 2 transformation
(Age < 20)*(Income+1000)+(Age>=20)*(Income+2000)

Example 2 results

It may be helpful to look at how this expression works on the first two rows.

Calculation for the first row:

(23<20)*(22000+1000)+(23>=20)*(22000+2000) = 0(23000) + 1(24000) = 24000

Calculation for the second row:

(15<20)*(5500+1000)+(15>=20)*(5500+2000) = 1(6500) + 0(7500) = 6500
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CHAPTER 12

Importing Data
About this chapter
This chapter presents an example of importing data from a comma delimited ASCII (text) file into
NCSS.

The ASCII file
Following is a set of data contained in the file ASCII.TXT in your \NCSS97\DATA subdirectory. We
will now go through the steps necessary to import the data from this file.

Bob,2,4,22,5
Judy,5,44,22,4
Sam,1,32,42,9
Mary,4,1,22,23
John,19,22,44,1
Linda,3,11,2,14

How to import ASCII.TXT
1 Press the New Database

button on the toolbar.

It is necessary to clear the
previous database.
Otherwise, the imported data
would be added to it.

A dialog box, entitled Create
a New Data File, will appear.

2 Indicate that you want a
Spreadsheet-type data file
since this is a small set of
data.

Since this is the default, just
click Ok.
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3 Select Import from the File
menu.

4 Select ASCII Delimited *.TXT
from the Select the File Type
selection box.

5 Press the Select a File to
Import button to specify the file
name.
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6 Click on the Ascii.txt in the Data
directory to specify the desired
file.

7 Press the Open button to finish
selecting the file.

8 Press the Next button to move on
to the next import screen.

9 Since the correct delimiter (a
comma) is specified, you are
ready to finish. Click the Finish
button to begin the import.
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The imported data will appear in the Data window.

Note that the imported database resides in your computer’s memory, not on the hard disk. If you want
to make a permanent copy of your data, you should select Save As from the File menu and save a
copy of the imported data to your hard disk.
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CHAPTER 13

Value Labels
About this chapter
Value Labels provide a mechanism to attach labels to coded data. For example, in a questionnaire you
might have questions whose responses fall along a Likert scale. Perhaps you have entered the data as
numeric values from 1 to 5. Value labels may be attached to the responses so that the 1 shows up on
your printout as “Strongly Agree” and 5 is displayed as “Strongly Disagree.”

This chapter will provide you with a step by step outline of how to use value labels. The data for this
example come from a four-item questionnaire that was given to twenty people as part of a political poll.
The first three questions contain demographic information about the individual. The fourth question is
their opinion about a hot political issue. You will find these data in the POLITIC database. The data
were coded numerically for easy data entry as follows:

POLITIC Database
AgeGroup

1 = 25 and under
2 = 26 to 34
3 = 35 to 55
4 = 56 and above

State
1 = California
2 = Virginia
3 = Texas
4 = Other

Party
1 = Democrat
2 = Republican
3 = Other

Issue
1 = Strongly agree
2 = Agree
3 = Neutral
4 = Disagree
5 = Strongly disagree
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Adding the value labels
The next step is to add the value labels to the database. This is done by entering the values and
corresponding labels in adjacent columns of the database. Leaving space for additional response
variables, we put the value labels in columns 15 through 22. C15 contains the values of AgeGroup, C17
contains the values of State, and so on.

Note that we have resized the column widths to make the display easier to read (C15, C17, C19, and
C21 are narrower than usual).

Although in this example we are constructing value labels for each variable, you do not have to do this.
You can label as many or as few variables as you like.

Attaching the value labels to the variables
The final step is to attach the value-label columns to the appropriate variables. This is accomplished as
follows:

1 Click the Variable Info tab.

2 Use the vertical scroll bar
or the Page Up key to
reposition the view to the
top of the Variable Info
datasheet.

3 Click in the first cell under
Value Labels to set the
spreadsheet cursor there.
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4 Type C15.
Press Enter.
Type C17.
Press Enter.
Type C19.
Press Enter.
Type C21.
Press Enter.

This attaches each value
label column to the
approriate variable.
Note that you may use
the value label more
than once.

Using the value labels in a report
We will now show you how the value labels change the output of the Frequency Table procedure.

1 Select Frequency
Tables from the
Descriptive
Statistics menu.
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2 Enter AgeGroup-Issue as
the Discrete Variables.

3 Run the procedure by
pressing the Run button.

The output appears as
shown.

Notice that the value labels
have not been used.
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4 Select Format tab to
display the Format panel.

5 Select Both in the Value
Labels box.

6 Run the analysis again by
pressing the Run button.

The output window appears as shown.

Note that the value
labels are now
displayed.
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CHAPTER 14

Database Subsets
About this chapter
It is often useful to store all of your data in one large database and then analyze various subsets of the
database as necessary. This can often be accomplished using the Filter mechanism. Sometimes you will
find it more convenient to create a subset of the original database that only contains those rows that you
want to analyze.

This chapter will take you through the steps necessary to create a subset of the POLITIC database
(described in Chapter 13) which contains those individuals with AgeGroup equal to 2 (26 to 34).

If you have not already done so, please open the POLITIC database now by selecting Open from the
File menu of the Data window.

Step 1 - Sort the database
The first step is to sort the POLITIC database by the variable (or variables) that you want to subset on.
This is done as follows.

1 Select Sort from the Data
menu.
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2 Select AgeGroup as the
variable to sort the database
by. This may be done by
using the drop-down menu
or by double clicking.

3 Click Ok to sort the
database by the selected
variable.

Step 2 - Copy
subset into new database
The next step is copy the selected data from the POLITIC database to the new database (which will be
named POLITIC2).

The database will be sorted by
Agegroup.

1 Select the desired subset by
dragging the mouse from row 5 of
column 1 (AgeGroup) to row 11 of
column 4 (Issue). Your selection
should appear as shown.

2 Press Ctrl-C to copy the selected
data to the Windows clipboard (the
clipboard is the name of temporary
holding area used by Windows to
store information that has been cut
or copied).

3 Select New from the File menu to
create the subset database.
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4 Select No from the
message box that
appears and asks if
 you want to save
changes.

It is important not to save the sorted database because the value labels have also been sorted--something
we do not want.

5 Click Ok to create a
spreadsheet type
database.

6 Position the cursor in
the upper left cell of
the new database by
clicking in it.

7 Press Ctrl-V to paste
the clipboard data into
the new database.
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8 Select Save As from the
File menu to name and
save this new database.

9 Enter politic2.s0 as the
name of the new
database.

Click Save.

Step 3 - Copy variable info to new database
The next step is to copy the variable information datasheet to the new database.

1 Open the POLITIC
database by selecting it
from the File menu.
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2 Click on the Variable Info
tab to move to the
Variable Info datasheet.

3 Select the information to
be copied by dragging the
mouse across it.

4 Press Ctrl-C to copy the
information to the
clipboard.

5 Open POLITIC2.S0 by
selecting it from the File
menu.

6 Move to the Variable Info
datasheet by clicking the
Variable Info tab.
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7 Position the cell cursor over
the cell containing C1.

8 Press Ctrl-V to paste the label
information into the subset
database.

The result will appear as
shown.

Step 4 - Copy value labels to the new database
The final step is to copy the value labels from the old database to the subset database.

1 Open the POLITIC.S0
database by selecting it
from the File menu.

2 Select Yes to save the
changes that you
have just made to
the POLITIC2
database.
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3 Enter politic2.s0 in the File Name
field of the Save File As dialog
box.

Click the Save button.

When asked, indicate that you
want to replace the previous
version of this file.

4 Reposition the datasheet so that
the first column is C15. Drag the mouse across and down so that all of the value labels are selected
as shown below.

5 Press Ctrl-C to copy the selected information to the clipboard.

6 Open the POLITIC2.S0
database by selecting it
from the File menu.
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7 Reposition the datasheet so that variable C15 is at the left.

8 Click in the first row of variable C15 so that this is the active cell.

9 Press Ctrl-V to copy the information. The final result should appear as below.

10 Select Save from the File menu to save the database before you forget.

That’s it. Let’s briefly review the steps:

1 Sort the database by the variables on which you want to subset.

2 Copy the subset data to a new database.

3 Copy the variable info from the old database to the subset database.

4 Copy value label information from the old database to the subset database (if it exists).
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CHAPTER 15

Simulation
About this chapter
There are many situations in which you want to generate data that follow a known distribution. For
example, you may want to generate 100 uniform random numbers as an aid in selecting a random
sample or you may want to generate five columns of normal random numbers to experiment with a
particular statistical test. This chapter will show you how to use transformations to generate simulated
data.

NCSS directly generates two types of random numbers: uniform and normal. Other types of random
numbers may be generated by using their inverse probability function on a set of uniform random
numbers.

Generating uniform random numbers
In this tutorial you will generate 100 uniform random numbers.

You should begin this tutorial with an empty database. If your database is not empty, follow the
instructions on page 14 to clear it.

1 Move to the Variable Info
datasheet by clicking the
Variable Info tab.
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2 Enter 100 in the Number of
Rows box.

This specifies the number of
rows to be generated.

3 Enter Uniform(3) as the
transformation for variable C1.

Note that the “3” in the
parenthesis is ignored. The
program generates a random
“seed” so that a different set of
random numbers will be used
each time you recalculate the
spreadsheet.

4 Press the Apply Transformation button to generate the random numbers.

5 Click the Sheet1 tab to view the data.

The data will appear as shown.
However, the numbers
themselves will be different
since each recalculation uses a
different starting seed.

6 Press the Apply
Transformation button a few
more times to generate new
sets of random numbers.
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Simulating the t-test with n = 5
We will now run a simulation in which we generate 100 one sample t-test values with a sample size of
five. Four of the values will come from a normal distribution with mean 50 and standard deviation 2.
The fifth value will come from a normal distribution with mean 50 and standard deviation 15. The t-test
will test the null hypothesis that the population mean of the sample is 50.

It will be interesting to study the distribution of these t-values since the t-test makes the assumption that
all five data values follow identical distributions. This simulation will allow us to study the distortion that
occurs when this assumption is not met.

1 Enter 100 for the number of
rows.

2 Enter the new variable names.

3 Enter the transformations.
Notice that we multiply the
random normal by the
standard deviation (2 or 15)
and then add the mean (50).

4 Enter 0.0000 as the format for
each of the variables. This will
make the data much easier to
read.

5 Move to the empty spreadsheet by clicking Sheet1.
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6 Click the Apply
Transformation button
to generate the
simulated data. Your
results will be similar to
ours.

Note that if you have
made an error in
entering the
transformation
formulas, you will have
to go back to the
Variable Info datasheet
to make corrections.

There are many ways to analyze the results. One of the easiest is to sort the Tvalue column and count
the number of rows whose values are outside the theoretical bounds. If these data had come from a
normal distribution with a mean of 50 and a standard deviation of 2, you can use the Probability
Calculator to determine the theoretical cut off values. The two-tail critical value for a t distribution with
four degrees of freedom and alpha = 0.05 is 2.78. Hence, you would expect that five of the one
hundred values would be less than -2.78 or greater than 2.78.

Here’s how to sort the data:

4 Scroll from through your data, counting how many values are less than -2.78 or greater than 2.78.

In our case only one row is outside the range. We repeated this simulation several times and never
found more than three values outside the range, much less than the five values that the null hypothesis
predicted.

1 Select Sort from the Data
menu. This will bring up
the Sort window.

2 Select Tvalue as the sort
variable.

3 Click Ok to perform the
sort.
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CHAPTER 16

Cross Tabs on
Summarized Data
About this chapter
This chapter presents an example of how to enter and analyze a contingency table that has already been
summarized.

Sample Data
The following data are the results of a study that tested the impact of three drugs on a certain disease.

Drug

Disease Type 1 Type 2 Type 3
Yes 15 28 44
No 4 7 9

These data are entered into an NCSS database as follows.

Notice that we have created three variables:

1 One containing the column
identification number (Drug).

2 One containing the row identification
number (Disease).

3 One containing the counts (Count).
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Filling out the Cross Tabulation window
The next step would be to fill out the Cross Tabulation window. This is done as follows.

1 Choose Cross Tabulation from the Descriptive Statistics submenu of the Analysis menu. This will
load the Cross Tabulation
window.

2 Enter Drug in the Discrete
Variables box under Table
Columns heading.

3 Enter Disease in the Discrete
Variables box under Table
Rows heading.

4 Enter Count in the Frequency
Variable box.

5 Press the Run button to run the
analysis.

The final result will appear as follows.
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